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Read through this operating manual carefully before use and become familiar with the product. 
Installation and start-up should not be carried out before reading and understanding this 
document. Keep this manual readily available so that you can reference it as needed. 
 

1.1  What Is the Purpose of this Operating Manual? 
This manual serves as an aid for the installation and operation of the product and supports the 
technical staff with all operating and maintenance tasks to be performed. Furthermore, this 
manual is aimed at preventing dangers to life and health of the user and third parties. 
 

1.2  Who Is this Operating Manual Targeted to? 
The operating manual provides a code of conduct for personnel tasked with the setup, 
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with 
respect to the operation of gas engines and basic knowledge of electronic ignition systems are 
necessary. Persons who are only authorized to operate the gas engine shall be trained by the 
operating company and shall be expressly instructed concerning potential hazards. 
 

1.3  Which Symbols Are Used in the Operating Manual? 
The following symbols are used in this manual and must be observed: 

 

Example 

This symbol indicates examples, which point out necessary handling steps 
and techniques. In addition, you receive additional information from the 
examples, which will increase your knowledge. 

   

 

Notice 

This symbol indicates important notices for the user. Follow these. In 
addition, this symbol is used for overviews that give you a summary of the 
necessary work steps. 

   

 

Warning 

This symbol indicates warnings for possible risks of property damage or 
risks to health. Read these warning notices carefully and take the 
mentioned precautionary measures. 

   

1 General Information 
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Danger 

This symbol indicates warnings for danger to life, especially due to high 
voltage. Read these warning notices carefully and take the mentioned 
precautionary measures. 

  
 

1.4  Which Abbreviations/Acronyms Are Used in the Operating Manual? 
In the operating manual or the user interface, the following abbreviations/acronyms are used. 

Abb. Term Description Explanation 

CAN bus Controller Area Network 
bus 

Bus for control 
devices/ networks 

Asynchronous serial 
connection system for 
linking control units 

CE Conformité Européenne Conformity with EU 
directives 

Mark based on EU legislation 
for certain products in 
conjunction with product 
safety 

CPU Central Processing Unit     

CSV Comma-separated 
Values 

  Text file for storage or 
exchange of structured data 

DC Direct Current     

EMC Electromagnetic 
Compatibility 

  Compatibility of electrical or 
electronic equipment items 
with their surroundings 

ESD Electrostatic Discharge     

LED Light Emitting Diode   Light emitting electronic 
semiconductor 

MAP Manifold Absolute 
Pressure 

    

MAT Manifold Air 
Temperature 

    

MICT MOTORTECH Integrated 
Configuration Tool 

  Configuration software for 
MOTORTECH control units 
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Abb. Term Description Explanation 

SCR Selective Catalytic 
Reduction 

  Technology for the reduction 
of nitrogen oxides in exhaust 
gases 

USB Universal Serial Bus   Serial connection system to 
link a computer to external 
devices 
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2.1  General Safety Instructions 
MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to 
operate. Nevertheless the equipment can cause risks or damage can occur, if the following 
instructions are not complied with: 

– The gas engine must only be operated by trained and authorized personnel. 

– Observe all safety instructions of the system and all safety instructions of the system 
operator. 

– Operate the equipment only within the parameters specified in the technical data. 

– Use the equipment correctly and for its intended use only. 

– Never apply force. 

– For all work such as installation, conversion, adaptation, maintenance, and repair, all 
equipment must be disconnected from the mains and secured against unintentional 
reactivation. 

– Perform only such maintenance and repair work as is described in this operating manual, 
and follow the instructions given while working. 

– Only use spare parts supplied by MOTORTECH for the maintenance of the device. 

– Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance with the instructions will void any warranties for the proper function of the 
equipment as well as the responsibility for the validity of the certifications. 

– Safety devices must not be dismounted or disabled. 

– Avoid all activities that can impair the function of the equipment. 

– Operate the equipment only while it is in proper condition. 

– Investigate all changes that occur during operation of the gas engine or electronic engine 
control. 

– Ensure compliance with all laws, directives, and regulations applicable to the operation of 
your system, including such not expressly stated herein. 

– If the system is not entirely tight and sealed, gas may escape and result in explosion hazard. 
The inhalation of gas can also lead to death or severe health damages. Therefore, upon 
completion of all assembly works, always check the system's tightness. 

– Always ensure adequate ventilation of the engine compartment. 

– Ensure a safe position at the gas engine. 

– There is a risk of burning on hot surfaces. Allow the engine to cool down before starting any 
work. 

– Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all 
work on the engine. 

2 Safety Instructions 
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– Noise from the system can cause permanent or temporary damage to your hearing. Wear 
suitable hearing protection at the system. 

– Your behavior can reduce possible residual risks to a minimum. Observe responsible 
handling of the gas engine and the gas-carrying system. 

 

2.2  Electrostatic Discharge Hazards 
Electronic equipment is sensitive to static electricity. To protect these components from damage 
caused by static electricity, special precautions must be taken to minimize or prevent 
electrostatic discharge. 

Observe these safety precautions while you work with the equipment or in its vicinity. 

– Before performing maintenance or repair work, ensure that the static electricity inherent to 
your body is discharged. 

– Do not wear clothing made from synthetic materials to prevent static electricity from 
building up. Your clothing should therefore be made of cotton or cotton mix materials. 

– Keep plastics such as vinyl and Styrofoam materials as far away from the equipment as 
possible. 

– Do not remove the circuit boards from the housing of the device. 
 

2.3  Information on Electric Isolation 
If ground and earth potential are not properly isolated, the following problems as well as others 
can occur: 

– Electromagnetic interferences (e.g. ground loops) 

– Signal corruption (e.g. of the analog voltage signal) 

– Unwanted leakage currents 

Therefore, earth potential and the negative pole of the power supply of all devices in the electric 
assembly that provide the option, should be connected separately. If possible, the negative pole 
of the power supply should only be connected to earth potential at one point in the entire 
system. 
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Wiring Example 
      Device with 

shielded wires 
Device featuring 
protection class II 

 

    

 

Occurrence of ground loops 

The devices shown in the following image do not feature the possibility to 
connect the earth potential and the negative pole of the power supply 
separated from each other. How ground loops are created. 

A ground loop is a ground connection of an electric wiring assembly that is 
closed as a loop. Due to impedance (resistance R > ) of the loop, low-
frequency interference currents can lead to an unwanted voltage drop in the 
signal path. 

  Device 1   Device 2 

 
    Ground loop   
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2.4  Special Safety Instructions for the Device 
  

 

Explosion hazard! 

Do not disconnect any connectors while the system is live. If the system is 
located in a hazardous area, there is a risk of explosion. 

      

 

Explosion hazard! 

Only use the NOX sensor for measurement in non-explosive gas mixtures, as 
explosive gas mixtures can ignite on the hot sensing element. Especially in 
the case of engine malfunction, make sure that no unburned gas mixture 
enters the exhaust pipe. 

    

 

Operational safety! 

All screws of the connectors must be adequately tightened. 

    

 

Operational safety! 

The proper functioning of the device is only guaranteed if the device is 
operated within the permissible supply voltage range. Therefore, use a 
power supply in accordance with the specifications in the operating 
manual. 
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Risk of injury! 

The VariSCR emission controller is designed for operation in circuits with 
protected extra-low voltage with safe electrical isolation (PELV). The 
voltages in these circuits must not exceed 50 V AC or 75 V DC. 

The VariSCR emission controller must not be electrically connected to 
circuits which carry dangerously high voltages or which could lead to a 
single failure. 

Therefore, the following conditions, among others, must be fulfilled: 

– The power supply may only be provided from power supply units with 
safe electrical isolation or from batteries. 

– Relays with safe isolation must be used for coupling to circuits that 
carry dangerous voltages or could carry in the event of a failure. 

– All currently applicable standards and regulations must be taken into 
account. 

   

 

Risk of burning! 

The surfaces of the system may heat up to high temperatures. Ensure good 
heat transfer through ventilation when installing in the control cabinet. 

    

 

Risk of burning! 

There is a risk of burns when touching the sensing element of the NOX 
sensor because the sensing element becomes hot during operation. 
Therefore, note the following points: 

– Therefore, install the sensing element on the exhaust pipe at a suitable 
location where people at the plant cannot be burned by it, or attach a 
protective grid around the sensing element to prevent contact with the 
sensing element. 

– The sensing element must have cooled down sufficiently at the end of 
operation before you can touch the sensing element again. 

    

 

Danger of damage to health! 

If AdBlue® evaporates, harmful gases can be produced. Therefore, avoid 
contact of AdBlue® with hot surfaces (e.g. on the catalytic converter). 
Furthermore, when working with AdBlue®, observe the applicable safety 
regulations. 
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Danger of interference with radio reception! 

The device is not intended for use in residential areas and cannot ensure 
adequate protection of radio reception in such environments. 

  
 

2.5  Proper Disposal 
After the expiration of its service life, MOTORTECH equipment can be disposed of with other 
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally 
friendly disposal. 
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3.1  Functional Description 
The NOX emission controller VariSCR is a component of an exhaust aftertreatment system based 
on an SCR catalytic converter. The emission controller evaluates the signals from sensors and 
controls the AdBlue® injection into the catalytic converter according to the parameters 
determined. The signals from the MAP and MAT sensors and the NOX sensor upstream of the 
catalytic converter are used for feed forward control. The signal from the NOX sensor after the 
catalytic converter then enables the system to be regulated more precisely. 

To ensure the system functions properly, the temperature at the dosing valve is monitored and, 
if necessary, it is cooled or heated. In addition, the emission controller offers the following 
monitoring functions: 

– Monitoring of pressure and speed of the AdBlue® pump 

– Monitoring of the exhaust temperature before and after the catalytic converter 

– Monitoring of the NOX sensors and temperature sensors function 

The emission controller is configured using a connected computer. The software used for this 
purpose is also used to display current system data and error messages. 
 

3.2  Applications 
The full functionality of the VariSCR emission controller can only be guaranteed if the 
components of the MOTORTECH SCR system are used, consisting of: 

– SCR catalytic converter 

– NOX sensors  

– Temperature sensors  

– Pump module  

– Dosing unit  

– MOTORTECH cable harnesses including MAT sensor PT100 and MAP sensor 

Other required components (not included): 

– Urea tank including level sensor and piping 

– Master Generator & CHP Control System 

Two SCR systems are generally required for V-engines. 

Any use other than the one described in the operating manual shall be considered improper use 
and will result in the voiding of all warranties. 

3 Intended Use 
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System Overview (Example) 

 

 NOX Emission controller VariSCR  Engine 

 Dosing unit (incl. pressure and temperature sensor, 
dosing valve and heating) 

 Master Generator & CHP 
Control System 

 Pump module  AdBlue® tank 

 NOX and temperature sensor before the SCR catalytic 
converter 

 Exhaust tract 

 SCR catalytic converter  MAP and MAT sensor 

 NOX and temperature sensor after of the SCR catalytic 
converter 
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4.1  Technical Data 

4.1.1 Certifications 
The emission controller VariSCR is certified according to the following directives: 

CE 
EMC Directive 2014/30/EU 

– EN 61326-1:2013 – Electrical equipment for measurement, control and laboratory use. EMC 
requirements. General requirements 

– EN 55011:2009 + A1:2010 – Industrial, scientific and medical equipment. Radio-frequency 
disturbance characteristics. Limits and methods of measurement 

– Group 1, Class A 

RoHS Directive 2011/65/EU 

The EU Declaration of Conformity can be found as a PDF file on the storage device enclosed with 
the device. 
 

4.1.2 Mechanical Data 
The VariSCR emission controller has the following mechanical characteristics: 

Feature Value 

Dimensions 160 mm x 126 mm x 61 mm (6.30" x 4.96" x 2.40") 
(length x width x height) 

Weight 766 g (1.7 lbs)  

Shape of device See chapter Overview Drawings on page 22 

Mechanical environmental 
conditions 

Protection: IP20 

Climatic environmental 
conditions 

–20 °C to +60 °C (–4 °F to +140 °F) 

Max. 85 % humidity without condensation 
up to 3,000 m (9,842') above sea level 

  
 

4.1.3 Warning Notices on the Device 
Top of Device 
WARNING! Read and understand the installation and operating manual prior to installing or 
making any adjustments. Do not disconnect equipment unless power has been switched off. 
 

4 Product Description 
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4.1.4 Product Identification – Labeling on the Device 
You find the numbers required for unique product identification on the label on the side of the 
device: 

– Part number of the emission controller (P/N) 

– Serial number of the emission controller (S/N) 

– Arrangement number of the emission controller (A/N) 

– Revision number of the emission controller indicating its precise construction status (R/N) 

 

(Exemplary representation) 
 

4.1.5 Electrical Data 
The VariSCR emission controller has the following electrical characteristics: 

Feature Value 

Power consumption Max. 180 W 

Power supply Nominal voltage: 24 V DC 
Operating voltage: 18 V DC to 32 V DC 

Required current Max. 10 A 
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Electrical Data for Inputs and Outputs 
The inputs and outputs of the emission controller have the following electrical data: 

Inputs and outputs Values/characteristics 

Binary inputs – Input voltage up to 32 V DC 

– Input current at least 5 mA for high level (approx. 12 mA at 
24 V DC) 

– galvanically isolated 
(rated insulation voltage: max. 70 V DC) 

When the reset signal is given, the high level must be present 
at the relevant input for at least 50 ms before it is possible to 
initiate the reset. 

Binary outputs – Inactive: output is high-impedance 

– Active: output is low-impedance 

– Switching voltage: max. 32 V 

– Current: max. 100 mA 

– Max. voltage drop at 100 mA: 2.5 V 

– galvanically isolated 
(rated insulation voltage: max. 70 V DC) 

Analog voltage input – Permissible voltage: 0 V to 10 V 

– Input resistance: 12.4 kΩ 

Analog current input – Permissible current: 0 mA to 20 mA 

– Max. difference in potential relative to device ground: 
+3.5 V 

– Input resistance: max. 25 Ω 

Analog voltage output – Output voltage: 0 V to 10 V 

– Working resistance: min. 500 Ω 

Analog current output – Output current: 0 mA to 20 mA 

– Working resistance: max. 500 Ω 

  

Electrical Data for Connection of the Pump Module 
The connections of the pump module have the following electrical data: 

Feature Value 

Power supply for the pump 18 V DC to 32 V DC; max. 1.5 A 
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Feature Value 

Output for control signal 
for pump speed 

– Open collector 

– Voltage: 18 V DC to 32 V DC 

– PWM: 100 Hz 

– Current: Max. 30 mA 

Input for feedback signal 
for pump speed 

– NPN with pull-up resistor 12 kΩ 

– Input voltage up to 32 V DC 

– Frequency: 0 Hz to 500 Hz (square wave signal) 

  

Electrical Data for Connection of the Dosing Unit 
The connections of the dosing unit have the following electrical data: 

Feature Value 

Power supply of the 
integrated sensors 

5 V DC; max. 30 mA 

Analog voltage input for 
AdBlue® pressure 

– Permissible voltage: 0 V DC to 4.5 V DC 

– Measuring range: 0 bar to +19.5 bar abs. (0 psi to 
+282.8 psi abs.) 

– Measuring tolerance: 2 % of measured value 

Analog voltage input for 
AdBlue® temperature 

– Permissible voltage: 3.3 V DC to 0.5 V DC 

– Measuring range: –50 °C to +150 °C (–58 °F to +302 °F) 

– Measuring tolerance:  
+/–4 °C (in the range 0 °C to +90 °C) 
+/–7.2 °F (in the range +32 °F to +194 °F) 

Connection for the dosing 
valve 

PWM: 5 kHz, 18 V to 32 V; max. 1 A 

Connection for the heating 
resistor 

Power supply: 18 V DC to 32 V DC; max. 2 A 

  

Electrical Data of the Connections for the Sensors on the Catalytic Converter 
The connections of the sensors have the following electrical data: 

Feature Value 

Power supply of the 
sensors 

18 V DC to 32 V DC; max. 1.5 A 

  



4 Product Description 
 

Rev. 06/2020 21 

Electrical Data of the Connections for the MAP and MAT Sensor 
The connections of the sensors have the following electrical data: 

Feature Value 

Input for the MAP sensor – Permissible current: 4 mA to 20 mA 

– Measuring range: 0 bar to 3 bar (0 psi to 43.5 psi) 

– Measuring tolerance: 4 % of measured value 

– Common mode offset voltage at I in +/I in - against GND: 
0 V DC to 3 V DC 

– Power supply of the sensor: 15 V DC to 25 V DC; max. 30 A 
load 

Input for the MAT sensor – Sensor type: PT100 

– Power supply: 2 mA 

– Three-wire technology 

– Measuring range: –50 °C to +150 °C (–58 °F to +302 °F) 

– Measuring tolerance:  
+/–1.5 °C(in the range –20 °C to +120 °C) 
+/–2.7 °F (in the range –4 °F to +248 °F) 

  
 

4.1.6 Interfaces 
USB 
– Compatible with USB 1.1 and USB 2.0 

– The connector type B is only suitable for temporary data exchange and not for a permanent 
connection. 

CAN Bus 2.0B Interface 
– As per ISO 11898, up to 1 Mbit/s 

– Transient-proof (automotive classification) 

– Max. 110 participants 

Modbus Interface 
– RS485 standard 

– Max. 32 participants 

– Full duplex (4-pole) or half duplex (2-pole) 
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Field bus protocols 

No emission-specific values are currently available in the field bus 
protocols. 

   
 

4.1.7 Overview Drawings 
Ports/Connections and LEDs 
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Designation Function 

Binary Inputs Binary inputs are available for a reset and a start/stop signal. The 
Engine Running input can be used to enable the optional mixture 
control (see Wiring – Binary Inputs on page 36). 

Binary Outputs The binary outputs signal the status of the emission controller and 
the SCR catalytic converter (see Wiring – Binary Outputs on 
page 37). 

Analog Inputs/ 
Outputs 

The analog inputs and outputs can be used for the optional mixture 
control. 

 

Manual/Auto (switch) Switch for changing between manual and automatic operation (see 
Manual and Automatic Operation on page 45) 

Open/Close; 
Reset 

An error can be reset by simultaneously pressing the Open and 
Close buttons. 

SCR Catalyst Sensors Connection of the NOX sensors and the temperature sensors before 
and after the catalytic converter via CAN bus 

Pump Module Connection of the pump module 

Dosing Unit Connection of the dosing unit 

MAT Connection of the temperature sensor 

MAP Connection pressure sensor 

Status The LED flashes: 

– green: The emission controller works without errors. 

– Orange: A warning occurred. 

– red: An error occurred. 

You can find details about status signaling in the following 
information box. 

For additional information on warnings and errors, read section 
Runtime Data – Message Log on page 87. 

Manual/Auto (LED) The LED lights up: 

– green: The emission controller is in automatic mode and is 
controlled by the master control. 

– Orange: The emission controller is in manual mode. 

USB Port for data transmission to the PC. Data transmission is signaled 
by the blinking LEDs TXD and RXD (TXD=Data are being sent, 
RXD=Data are being received). 
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Designation Function 

CAN Connection for communication with a master control via CAN bus. 
Data transmission is signaled by the blinking LEDs TXD and RXD 
(TXD=Data are being sent, RXD=Data are being received). 

RS485 Port for communication via Modbus with superordinate control 
devices. Data transmission is signaled by the blinking LEDs TXD and 
RXD (TXD=Data are being sent, RXD=Data are being received). 

Stepper Motor + 
Encoder 

The connections are currently not in use. 

 

Power Connection for the supply voltage (see Wiring – Power Supply on 
page 28). This LED lights up if the supply voltage is available. 

  

  

 

Status signaling 

The status of the VariSCR emission controller is signaled via the LED Status. 

– Flashing green: Error-free operation 

– Flashing orange: Warning 
Warnings can be acknowledged by simultaneous pressing of buttons 
Open and Close (in manual mode) or by the external reset signal. 
Warnings can for example be caused by: 

– Overload of the device 

– Overtemperature or over current error confirmed by MICT. 

– Flashing red: Error 
Errors can be acknowledged by simultaneous pressing of buttons Open 
and Close or by the external reset signal. Errors can for example be 
caused by: 

– Overtemperature 

– Low voltage 

– Over current 

– Alternate flashing of red and green: 
The supply voltage for the device was too low during start up. 
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5.1  Installation Instructions 
Unpack the emission controller without damaging it and ensure that the operating manual is 
always within reach of the device and easily accessible. Installation locations where strong 
vibrations or ambient temperatures of below –20 °C (–4 °F) or above +60 °C (+140 °F) are 
present are not permissible and result in the warranty being voided. 

  

 

Risk of destruction! 

The device must not be installed directly on or at the engine, as vibration 
and heat may cause damage to electronic components. 

   

 

Risk of destruction! 

Make sure that the device is not covered and ensure sufficient circulation of 
air. 

  

Scope of Supply 
The scope of supply of the VariSCR emission controller consists of the following components: 

– NOX Emission controller VariSCR 

– Storage device (USB flash drive or CD-ROM) including configuration software MICT 

– USB cable 

– Operating manual 

Installation of the VariSCR Emission Controller 
1. Install the VariSCR Emission Controller on a horizontal DIN rail in the control cabinet. 

2. When installing all other components of the exhaust aftertreatment system, observe the 
specifications and instructions of the respective manufacturers. 

 

5 Installation Instructions 
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Risk of destruction! 

The VariSCR emission controller contains separate circuits. If these are 
connected, this can cause damage to the device. Please adhere to the 
following points: 

– The GND connections must not be connected to each other. 

– The GND connections must not be used for the supply (24 V DC). 

– The GND connections may only be connected to the respective 
components (sensors, etc.). 

   

 

Risk of damage to the device! 

Incorrectly installed wiring can cause damage to the device. Please adhere 
to the following points: 

– Do not disconnect connectors under load. This can cause an arc. 

– Use the prescribed wire cross sections and suitable wire end ferrules. 

   

6 Wiring 
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Wiring of components 

If you are not using wiring harnesses manufactured by MOTORTECH, carry 
out the wiring according to the following specifications: 

– Power supply: 
3-wire cable, min. conductor cross-section 1.5 mm², max. cable length 
15 m (49') 
If the cable length is longer, a respective larger cross-section must be 
selected. 

– Pump: 
4-wire, shielded cable, min. conductor cross-section 1.5 mm², max. 
cable length 15 m (49') 

– Dosing unit: Valve and heater: 
4-wire, shielded cable, min. conductor cross-section 1.0 mm², max. 
cable length 15 m (49') 

– Dosing unit: Sensor signals (Press., Temp.): 
4-wire, shielded cable, min. conductor cross-section 0.2 mm², max. 
cable length 15 m (49') 

– MAT sensor: 
3-wire cable, min. conductor cross-section 0.2 mm², max. cable length 
15 m (49') 

– MAP sensor: 
2-wire cable, min. conductor cross-section 0.2 mm², max. cable length 
15 m (49') 

– Binary inputs and outputs: 
multicore cable, min. conductor cross-section 0.2 mm², max. cable 
length 30 m (98') 

– Analog inputs and outputs: 
multicore, shielded cable, min. conductor cross-section 0.2 mm², max. 
cable length 30 m (98') 

– CAN bus: 
4-wire, shielded bus cable, twisted in pairs, min. conductor cross-
section 0.34 mm², max. cable length 250 m (820') at 250 kbit/s 

– Modbus: 
6-wire, shielded bus cable, twisted in pairs, min. conductor cross-
section 0.25 mm², max. cable length 250 m (820') 
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6.1  Wiring – Power Supply 
  

 

Risk of injury! 

The VariSCR emission controller is designed for operation in circuits with 
protected extra-low voltage with safe electrical isolation (PELV). The 
voltages in these circuits must not exceed 50 V AC or 75 V DC. 

The VariSCR emission controller must not be electrically connected to 
circuits which carry dangerously high voltages or which could lead to a 
single failure. 

Therefore, the following conditions, among others, must be fulfilled: 

– The power supply may only be provided from power supply units with 
safe electrical isolation or from batteries. 

– Relays with safe isolation must be used for coupling to circuits that 
carry dangerous voltages or could carry in the event of a failure. 

– All currently applicable standards and regulations must be taken into 
account. 

     

 

Risk of injury! 

When the power supply to the VariSCR emission controller is established, 
the connected pump builds up the pressure. If the AdBlue® pipe system is 
not completely closed at this time, AdBlue® may leak and cause injury (e.g. 
splashing into the eyes). 

   

 

Operational safety! 

The proper functioning of the device is only guaranteed if the device is 
operated within the permissible supply voltage range. Therefore, use a 
power supply in accordance with the specifications in the operating 
manual. 

  

The power supply is wired using the 3-pole connector. In order to comply with the EMC 
requirements, it is necessary that the earth connection (Earth) is established with a cable that is 
routed separately from the negative pole (L –) and as short as possible. In addition to 
overcurrent protection, the power supply of the emission controller shall be equipped with a 
disconnecting device (e.g. by using a fuse switch disconnector). 
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L ≙ 18 V DC to 32 V DC (nominal voltage: 24 V DC) 

 

 

Variations 

1 Battery Generator Control unit 

 

 

2  Power supply 

 

 

3  Battery Charger 
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6.2  Wiring – Sensors on the SCR Catalytic Converter 
The sensors before and after the SCR catalytic converter are connected via CAN bus. The pump 
module is wired using the 6-pole connector in the device cover. To meet EMC requirements, 
install the control units of the NOX sensors and the control unit of the two temperature sensors 
on an earthed metal plate. 

 

      

  Module Sensors 

  1 NOX sensor before the catalytic 
converter 

  2 NOX sensor after the catalytic 
converter 

  3 Temperature sensors before and after 
the catalytic converter 

      
      
      
      
      
      
      
      
      

 

  
The modules can be wired in any order. The sensors are permanently connected to the CAN 
modules. 

Pin Designation Function 

1 

   S
CR

 C
at

al
ys

t S
en

so
rs

 CAN Hi Connection of the CAN bus which integrates the NOX 
sensors and the temperature sensors before and after 
the catalytic converter. 2 CAN Com 

3 CAN Lo 

4 CAN Shield 

5 Power Power supply of the sensors 

6 GND 
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Wiring of the sensors on the SCR catalytic converter via CAN 

When wiring the sensors to the SCR catalytic converter via CAN, observe the 
following notes: 

– Each bus end must be fitted with a terminating resistor of 120 Ω (see 
drawing). 

– The maximum wire length is 250 m (820') depending on the bit rate. 

– The stub lines to the sensors should be a maximum of 30 cm (11.81") 
long. 

– Only use cables that are specified by the manufacturer for use in the 
CAN bus. 
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6.3  Wiring – Pump Module 
The pump module is wired using the 5-pole connector in the device cover. 

 

Pin Designation Function 

7 

    
 P

um
p 

M
od

ul
e 

Power Power supply of the pump module 

8 Control Control signal for the pump 

9 RPM Feedback signal pump speed 

10 GND Ground of the pump module 

11 Shield Shield 
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6.4  Wiring – Dosing Unit 
The dosing unit is wired using the 9-pole connector in the device cover. 

 

Pin Designation Function 

1 

    
    

    
    

    
Do

si
ng

 U
ni

t 

Power Power supply of the dosing unit 

2 Press. Pressure signal 

3 Temp. Temperature signal 

4 GND Ground of the dosing unit 

5 Valve + Control signal for the dosing valve 

6 Valve – 

7 Heater Pwr. Control signal for the heating of the dosing unit 

8 Heater GND 

9 Shield Shield 
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Risk of destruction! 

The VariSCR emission controller contains separate circuits. If these are 
connected, this can cause damage to the device. Please adhere to the 
following points: 

– The GND connections must not be connected to each other. 

– The GND connections must not be used for the supply (24 V DC). 

– The GND connections may only be connected to the respective 
components (sensors, etc.). 

  
 

6.5  Wiring – MAT and MAP Sensor 
The MAT and MAP sensors are wired via the 10-pole connector in the device cover. The wiring of 
the MAT sensor is carried out in a three-wire circuit. To meet EMC requirements, install the MAP 
and MAT sensors so that the sensor housings have a conductive connection to ground/earth. 
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Pin Designation Function 

1 

    
    

  M
AT

 

Power Current source for the temperature sensor 

2 Signal Input for the temperature sensor signal 

3 Com Common return 

4 Shield Shield temperature sensor 

5 

    
    

    
    

    
 M

AP
 

Power Power supply for the pressure sensor 

6 I in + Current input for the pressure sensor signal 

7 I in – 

8 U in + Voltage input; not currently used 

9 GND Ground of the pressure sensor 

10 Shield Shield of the pressure sensor 

  

 

MAP sensor wiring for V-engines 

If two VariSCR emission controllers and only one MAP sensor are used for a 
V-engine, the wiring must be carried out as follows: 
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6.6  Wiring – Binary Inputs 
The binary inputs are wired using the 10-pole connector. The inputs can be switched both on the 
operating voltage side and on the ground side. 
L = 5 V DC to 32 V DC 

 

Pin Designation Function 

1 

    
    

    
    

    
    

    
    

    
    

    
Bi

na
ry

 In
pu

ts
 

Start/Stop + The binary input controls the release of the emission 
controller. When the high level is applied, the emission 
controller switches to the active operation mode. At 
engine standstill, the stop level (low level) must be 
applied in order to switch off the emission controller 
respectively to stop the injection of AdBlue®. 

2 Start/Stop – 

3 Engine Running + The binary input controls the release of the optional 
mixture control. 

 
4 Engine Running – 

5 GPI1 + Not currently used. 

6 GPI1 – 

7 GPI2 + Not currently used. 

8 GPI2 – 

9 Reset + If a high level is applied for at least 50 ms, the device 
exits the error mode and the emission controller is reset. 

 
10 Reset – 
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6.7  Wiring – Binary Outputs 
The binary outputs are wired using the 12-pole connector. The outputs can switch both the 
operating voltage and the ground. 

L = 5 V DC to 32 V DC; max. 100 mA 
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Pin Designation Function 

11 

    
    

    
    

    
    

    
    

    
    

    
Bi

na
ry

 O
ut

pu
ts

 

Error + The output is low impedance if an error has occurred. 
Serious damages can occur. The engine should be 
switched off by the master control. To exit the error 
state, the error needs to be acknowledged (refer to 
Acknowledging Faults on page 107). 

12 Error – 

13 Catalyst 
Overtemp. + 

The output is low impedance if a too high exhaust gas 
temperature has been measured before or after the 
catalytic converter. 14 Catalyst 

Overtemp. – 

15 GPO1 + – 

16 GPO1 – 

17 GPO2 + – 

18 GPO2 – 

19 Power + The output is low impedance when the supply voltage is 
present and the emission controller is ready for 
operation. 20 Power – 

21 Offline + The output has a low impedance if the VariSCR emission 
controller is in a state in which the SCR control does not 
yet function or only functions to a limited extent (e.g. 
if the catalyst temperature is too low). 

22 Offline – 
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6.8  Wiring – Analog Inputs and Outputs 
The analog inputs and outputs are wired using the 8-pole plug. 

 

Pin Designation Function 

23 

  A
na

lo
g 

In
pu

ts
 0-10 V U in + currently without function 

24 0-10 V GND 

25 0-20 mA I in + currently without function 

26 0-20 mA I in – 

27 Shield Shield 

28 

  A
na

lo
g 

Ou
tp

ut
s Position U out + Voltage and current output with shared ground. 

 29 Position GND 

30 Position I out + 
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Unused inputs and outputs 

Please note that the terminals for the analog inputs and outputs not 
selected in the MICT must remain unoccupied. 

  
 

6.9  Wiring – CAN Bus 
The wiring of the CAN bus interface for communication with other devices is done via the 4-pole 
connector. 

  First device Second-to-last device 

 
   Second device Last device 
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CAN bus wiring 

Note the following when connecting the CAN bus: 

– Each bus end must be fitted with a terminating resistor of 120 Ω (see 
drawing). 

– The maximum wire length depends on the bit rate: 

Bit rate Maximum wire 
length 

Maximum length 
of a stub 

Maximum length of 
all stubs 

1 Mbit/s 25 m (82') 1.5 m (5') 7.5 m (25') 

800 kbit/s 50 m (164') 2.5 m (8') 12.5 m (41') 

500 kbit/s 100 m (328') 5.5 m (18') 27.5 m (90') 

250 kbit/s 250 m (820') 11 m (36') 55 m (180') 

125 kbit/s 500 m (1,640') 22 m (72') 110 m (360') 

50 kbit/s 1,000 m (3,280') 55 m (180') 275 m (902') 

  

– Only use cables that are specified by the manufacturer for use in the 
CAN bus. 

    

 

Field bus protocols 

No emission-specific values are currently available in the field bus 
protocols. 
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6.10  Wiring – Modbus (RS485) 
The Modbus can be wired as half duplex or full duplex, and twisted cables must be used. With 
both variants the load resistance RT is the characteristic impedance of the cable. 

Wiring Half Duplex 
  
First device     Last device 

 
  Second device Second-to-last device   

Wiring Full Duplex 
  
Master     Last slave 

 
  First slave Second-to-last slave   
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Connection to VariSCR emission controller 
The Modbus is wired using the 6-pole connector. 

 

  

 

Field bus protocols 

No emission-specific values are currently available in the field bus 
protocols. 
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7.1  NOx Emission Control 
The emission regulation is carried out in two steps: 

Feed Forward Control 
The required AdBlue® injection quantity is calculated from the measured values of the NOX 
sensor before of the catalytic converter, the MAP and MAT sensors and the exhaust gas 
temperature. The calculation is carried out with the aid of a map table with up to eight points. 
This can be configured via the MICT (see Exhaust Control – SCR – Feed Forward Control on 
page 70). 

Adjustment 
Based on the measured value of the NOX sensor after the catalytic converter, a digital PID 
controller adjusts the configured emission value. By changing the opening time of the dosing 
valve, the AdBlue® injection quantity is adjusted until the corresponding NOX value is reached. 

The range of the PID controller is limited by the parameters of the map table of the feed forward 
control, thus overdosing is avoided. The emission value and the settings for the PID controller 
can be configured in the MICT (see Exhaust Control – SCR – Dosing Valve on page 69). 
 

7.2  Pump Self Test 
The pump self test checks whether the pump speed and pump pressure are within the minimum 
and maximum values specified in the configuration. Two types of pump self test are performed 
automatically by the VariSCR emission controller: 

– Initial Self Test 
The initial self test is performed automatically after starting the emission controller and 
after each error acknowledgment. In addition, the initial self test can be started manually by 
the user via the menu command Device -> Pump check. 

– Continuous Self Test 
The continuous self test is performed permanently during operation of the emission 
controller. 

The parameters for the pump self test are defined on the corresponding configuration page in 
the MICT. Refer to the section Exhaust Control – SCR – Pump Self Test on page 67. 
 

7.3  Control of the Pressure of the Pump 
The pressure of the pump is adjusted by a digital PID controller which reacts to the pressure 
signal of the dosing unit. The actual pressure is set by regulating the pump speed. The target 
pressure and the settings of the PID controller can be configured in the MICT. Refer to the 
section Exhaust Control – SCR – Pump Setup on page 66. 
 

7 Functions 
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7.4  Cooling of the Dosing Valve 
If the temperature at the dosing valve is too high, AdBlue® is pumped through the dosing unit by 
the pump in order to cool the valve and thus ensure functionality. The AdBlue® returns via an 
internal bypass line from the dosing unit to the tank. 

The cooling circuit remains active until the emission controller is disconnected from the power 
supply, even if the device has been switched off via the start/stop input. 

The temperature values at which the pump is switched on and off for cooling the dosing valve 
can be configured in the MICT. Refer to the section Exhaust Control – SCR – Pump Setup on 
page 66. 
 

7.5  Protection against Freezing of the Dosing Valve 
To protect the dosing valve from too low temperatures, the temperature sensor of the dosing 
unit is analyzed. If the temperature falls below the minimum temperature, the heating of the 
dosing unit is switched on. 

Protection against freezing is ensured until the emission controller is disconnected from the 
power supply, even if the device has been switched off via the start/stop input. 

The temperature values at which the heating of the dosing valve is switched on and off can be 
configured in the MICT. Refer to the section Exhaust Control – SCR – Dosing Valve on page 69. 
 

7.6  Manual and Automatic Operation 
The VariSCR emission controller can be operated in two modes: 

– Manual operation 

– Automatic operation 

Manual and automatic operation can be switched via the Manual/Auto switch or via the MICT. In 
this case, the MICT overwrites the switch position on the device. Switching via the Manual/Auto 
switch can be disabled by a setting in the MICT. If the status LEDs Manual or Auto are lighted up, 
this indicates the operation mode the emission controller is currently in. 

The emission controller must be in manual mode to download a configuration from the MICT to 
the device. In automatic operation, the MICT can only be used to display the data and to create 
log files. 

  

 

Risk of destruction! 

In manual operation, the signals of the master control are not analyzed. If 
you make any adjustments in the manual mode with the gas engine 
running, make sure that these settings do not endanger the correct 
operation of the gas engine. 
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When switching to automatic operation, emission control starts immediately. In manual 
operation, the pump and dosing valve can be controlled via the MICT, for example to vent the 
pump. 
 

7.7  Access Control 
You can protect the VariSCR emission controller against unauthorized access by establishing the 
access control in the MICT. The access control has four operating levels, three of which can be 
secured with different PINs. As a default setting, the access control is not activated. If the access 
control for the emission controller is activated, it is independent from the access levels that 
control authorizations within the MICT. 

  

 

Access Control 

A user is logged in to the Advanced Service access level on the MICT. He 
changes a configuration and would like to download the change to the 
VariSCR emission controller. Although he has the full authorization set in 
the MICT, he is prompted to log in with the PIN for the Level 3 (Master). This 
ensures that it is not possible for any user with an MICT and the generally 
valid password to change the configuration of your emission controller. 

  
Various functions are at your disposal on the four operating levels. The figure below illustrates 
this: 
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The following functions are available on the different levels: 

– Level 0 (Read Only) 
Enables read-only access for all users. 

– Level 1 (Operator) 
At this level, the user can carry out manual valve adjustment and manual pump adjustment. 
Beyond that, he can change the operation mode and can confirm errors. 

– Level 2 (Service) 
The service can also perform runtime adjustments and run the pump self-test manually. 

– Level 3 (Master) 
At this level, the master can also reset all PINs and enable or disable the access control. 
Moreover, only the master is authorized to download a changed configuration to the 
emission controller. 

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on 
page 49. 
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MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. Use the MICT to configure 
your VariSCR emission controller. 

Depending on the version of the MICT you are using, the range of functions may differ from the 
software version shown. 
 

8.1  MICT System Requirements 
For the installation of the MICT, the following minimum requirements must be fulfilled: 

– x86-compatible computer, at least performance class Intel Pentium 4 with 2 GHz 

– 128 MB free RAM 

– 250 MB free disk space 

– USB interface 1.1 or higher 

– Display with a resolution of at least 1440 x 900 pixels (WXGA+) 

– Microsoft® Windows 7, Windows 10 
 

8.2  MICT Installation 
The software for the installation of the MICT is on the data storage device (USB flash dive or CD-
ROM) enclosed with the VariSCR emission controller.  

To install the MICT, proceed as follows: 

1. Start the installation: 

– Via the menu: 
Start the file Start.exe on the storage device. Start the installation routine of the MICT 
via Software -> Install MICT. 

– Directly from the storage device: 
Start the installation routine of the MICT directly. It is on the storage device in the 
subdirectory Installation and for example named as follows: MICT-2.0.0-setup.exe. 

2. Run the installation. 
Follow the instructions of the installation routine. Note that the license agreement terms 
must be accepted before using the MICT. 

3. Install the USB driver via the menu as well or directly from the storage device. 

– Via the menu: 
Software -> USB Drivers -> Install USB Drivers 

– Directly from the storage device: 
Start the exe file in subdirectory Drivers(e.g. CDM21226_Setup.exe). 

▸ You have installed the MICT and can now connect your computer to the emission 
controller via the USB interface. 

 

8 Settings via the MICT 
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8.3  Access Levels in the MICT 
You can open the MICT on your computer e.g. Via Start -> Programs -> MOTORTECH -> MICT 2.x.x -> 
MICT 2.x.x. 

After opening the MICT, select the access level for which you have clearance. The access level 
controls the options you have at your disposal in the MICT. The password required for access 
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on 
page 107). 

 

The following access levels are available: 

– Read Only 
On this level, the user can open a configuration and transfer it to the device. However, he 
cannot make changes to the configuration. The user has read-only access to all other 
settings. 

– Customer 
This level enables the configuration of the basic functions required for operation in addition 
to the read-only function. 

– Service 
This level includes all functions needed for maintenance. 

– Advanced Service 
This level offers full access to all functions of the MICT and is enabled and accessible for 
specially trained personnel only. 

The following sections describe the options at your disposal with the Advanced Service access 
level. If you have registered for a different level, you cannot execute all functions shown. 
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8.4  Configuration Pages (Overview) 
The configuration pages are divided into the following sections: 

  

  

Pos. Area 

 Menu bar 

 Toolbar 

 Navigation bar 

 Configuration section 

 Status bar 

  
The functions in the menu, navigation bar, and the toolbar as well as the configuration section 
will be described in the following. 
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The status bar provides you with the following information (from left to right): 

– Status display 
Indicates whether a connection is established with the device: 

– Green display: connection established 

– Red display: the connection was interrupted and is being restored 

– Gray display: the connection is not established and is not being restored 

– Indication of the interface being used for the connection to the device 

– Indication of the device ID 

– Indication of the access level of the user in the MICT 

– Indication of the operating level for the VariSCR emission controller if access control has 
been activated and the user has logged on with a PIN. 

– Indication of the MICT program version 
 

8.5  Menu Bar and Toolbar 
The following functions are available to you via the symbols on the toolbar and the entries in the 
menu bar: 

Symbol Menu Function 

 

File -> New Creates a new configuration. 

 

File -> Open Opens an existing configuration. 

 

File -> Save / 
File -> Save As 

Saves the current configuration. 

  File -> Recent Documents The last five configuration files used are offered for 
selection. 

  File -> Close Closes the current configuration. 

  File -> Open trace Opens a runtime data record (trace file). Refer to the 
section Runtime Data on page 76. 

  File -> Open pickup trace Opens a saved recording of pickup signals (putrace 
file), for example from a MOTORTECH ignition 
controller. Pickup signals cannot be recorded by of the 
VariSCR emission controller. 
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Symbol Menu Function 

 

File -> Change Access 
Level 

Changes the access level for accessing the 
configuration data and functions. 

 

File -> Print Prints the current configuration. 

 

File -> Print To PDF File Prints the configuration to a PDF file. 

  File -> Print Preview Opens a print preview of the configuration. 

  File -> Quit Exits the MICT. 

 

Device -> Connect Connects to the device. 

 

Device -> Disconnect Cuts the connection to the device. 

 

Device -> Download to 
device 

Downloads configuration data from the computer to the 
device. This function can only be executed in manual 
mode. 

 

Device-> Upload from 
device 

Uploads configuration data from the device to the 
computer. 

 

Device -> Runtime data Opens the window Runtime Data. Refer to the section 
Runtime Data on page 76. 

 

Device -> Log Opens the window Log (Advanced Service only). Refer 
to the section Log on page 95. 

  Device -> Runtime 
adjustments 

Opens the window Runtime Adjustments (Service and 
Advanced Service only). Please refer to the section 
Runtime Adjustments on page 93. 

  Device -> Select Mode Opens the window Select operation mode in which you 
can select the operation mode. The following modes 
are possible: Manual operation mode, Automatic 
operation mode or Switch controls operation mode. 

  Device -> Manual valve 
adjustment 

Opens the Manual Valve Adjustment window. Refer to 
the section Manual Valve Adjustment on page 54. 
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Symbol Menu Function 

  Device -> Manual pump 
adjustment 

Opens the Manual Pump Adjustment window. Refer to 
the section Manual Pump Adjustment on page 54. 

  Device -> Pump check Starts the initial self test manually. 

  Device -> Temperature 
Extremes 

Opens a window in which the maximum and minimum 
temperature are displayed. These values are measured 
throughout the operating time on the board of the 
emission controller. 

  Device -> Error 
Acknowledge 

All operational errors are acknowledged. 

  Device -> Trigger Error The process currently being performed by the emission 
controller is aborted and the emission controller 
switches into error mode. 

  Device -> Access Control The setup for the access control to the device is 
described in a separate section. Please read the 
section Access Control for the VariSCR Emission 
Controller on page 57. 

  Settings -> Language Opens the window Select Language in which you can 
change the interface language of the MICT. 

  Settings -> Online update 
settings 

Opens the window Online Update Settings. Refer to the 
section Online Update Settings on page 56. 

  Settings-> Database 
settings 

Opens a dialogue window in various databases can be 
assigned as source for the MICT. 

  Settings -> Temperature 
scale 

Opens the window Select Temperature Scale, in which 
you can change the unit for the temperatures shown in 
the MICT. 

  Settings -> Display by 
cylinders 

This function is available for certain MOTORTECH 
ignition controllers and has no effect in conjunction 
with the VariSCR emission controller. 

  Document Has no function with the VariSCR emission controller. 

  Tools -> Coils Opens a database with information on MOTORTECH 
ignition coils. 

  Help -> Help Opens the online help function. 

  Help -> About MICT Opens detailed information on the MICT. 
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8.6  Manual Valve Adjustment 
You can manually adjust the dosing valve for optimization or test purposes. In addition, a 
manual adjustment of the dosing valve is also required to determine the feed forward control 
characteristic curve. On this, read the section Determine Values for Feed Forward Control on 
page 98. 

You open the window Manual Valve Adjustment in manual mode via the following entry in the 
menu bar: 

Device -> Manual valve adjustment 

 

You have the following possibilities to adjust the opening of the dosing valve: 

– -/+-keys 
Use the keys to adjust the current dosing valve opening by 0.1%, 1% or 10%. 

– Entry field 
You can directly enter the desired percentage opening in the field in the middle of the 
window, or increase or decrease the current value using the side arrows. 

For checking purposes, the current percentage opening of the dosing valve is displayed in the 
field Actual. 
 

8.7  Manual Pump Adjustment 
A manual test can be carried out to vent the pump before operation or to operate it at a constant 
speed for maintenance purposes. The settings for the test are made in manual mode using the 
following entry in the menu bar: 
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Device -> Manual pump adjustment 

 

The speed entered in the dialog window is set and held at the start of the test until a timeout 
occurs or the pressure range configured for the initial pump self test is reached (see Exhaust 
Control – SCR – Pump Self Test on page 67). 

You have the following options: 

– Parameters 
Enter the speed and timeout for the test. When the dialog window is opened, the values 
correspond to the settings of the initial pump self test. 

– Control 

– Start 
Click the button to start the test. 

– Set 
Click the button to transfer the changed parameters to the emission controller. 

– Stop 
Click the button to stop a running test. 

The status displays have the following meaning: 

– Running 
The test has been started and is running without errors. 

– Speed Timeout 
When the status display lights up, the speed did not match the value specified in the Speed 
field for longer than the time specified in the field Timeout. 

– Pressure Timeout 
When the status display lights up, the pressure range specified in the initial self test has not 
been reached within the Timeout (see Exhaust Control – SCR – Pump Self Test on page 67). 

– Success 
The required pump pressure was reached within the time specified under Timeout. 
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8.8  Online Update Settings 
The MICT uses data from various databases for the configuration. Such data can be updated with 
automatic online updates. The settings for the update can be entered with the following entry in 
the menu bar: 

Settings -> Online update settings 

 

You have the following options: 

– Enable automatic database updates 
Using the check box, you can enable and disable automatic online updates. As the default 
setting, the online update is activated and is executed daily (if an internet connection is 
established) at first start-up of the MICT. 

– Use a proxy to access the web 
Use the checkbox to activate settings for internet access via a proxy server, which you can 
then set up by entering http-Proxy and Port. 

– Show Log 
With this button, you can open a window in which the online updates performed are logged. 

– Update Now 
With this button, you manually start an online update. 

  

 

Online update 

After the online update, the updated data will only be used if these have 
been downloaded onto the device. However, this requires the relevant 
authorization. 

Whenever the configuration is uploaded from the device, the version of the 
configuration saved in the device will be compared with the version in the 
database. If the two versions are not the same, a window with additional 
instructions will open up. 
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8.9  Access Control for the VariSCR Emission Controller 
If the access control to the emission controller is activated, access to the following areas is 
possible with a PIN only: 

– Troubleshooting 

– Configuration (Transferring a configuration to the emission controller) 

The access control regulates the accesses to the emission controller via the MICT. For 
explanations concerning access control of the emission controller and the delimitation of the 
access levels in the MICT, refer to section Access Control on page 46. 

The access control functions can be accessed in the menu bar via: 

Device -> Access Control 
 

8.9.1 Enable/Disable Access Control 
   

 

Enable/Disable access control 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access control 
again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Reset all PINs on 
page 58. 

  

To enable or disable the access control, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Enable or Disable access control. 

2. Enter the PIN for the level Master (Level 3). 

3. Confirm the input with OK. 
 

8.9.2 Login/Logout 
If the access control is activated, you are prompted to log in if you want to execute functions that 
are allocated to a specific operating level. In addition, you can log in specifically to an operating 
level via the menu bar. 

To log into a specific operating level, proceed as follows: 

1. Open the input dialog via Device-> Access Control -> Login. 

2. First select the level you wish to log on to. 

3. Enter the PIN for the desired level. 
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4. Confirm the input with OK. 

▸ You are now logged into the corresponding level and can execute all functions that are 
allocated to this operating level without having to log in again. 

After completing the log-in, you can log out again as follows: 

Device -> Access Control -> Logout 
 

8.9.3 Changing the PIN 
To change the PIN for a specific operating level, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Change PIN. 

2. First select the level for which you wish to change the PIN. 

3. Enter the current PIN for the desired level. 

4. Enter the new PIN in the two subsequent fields. 

5. Confirm the input with OK. 

▸ The PIN for this operating level has now been changed. 
 

8.9.4 Reset all PINs 
To reset all PINs, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Reset all PINs. 

2. If you are not yet logged into the Master (level 3) level, you will be prompted to log in with 
the relevant PIN. 

3. Confirm the input with OK. 

4. To reset all PINs, you will be prompted again to enter the PIN for the level Master (Level 3). 

5. Confirm the input with OK. 

▸ All PINs are now reset to the value 0000. 

To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in 
case of emergency that was locked in this way, you have the following option: 

1. In the menu bar, select the entry Device -> Access Control -> Get reset all PINs request key to 
open a window with the same name. 

2. Send the request key with the serial number to your service contact person at MOTORTECH 
(refer to Customer Service Information on page 107). This key is valid only for the respective 
controller and only for a certain amount of time. 

▸ Your information will be verified, and you will receive an authorization key from your 
contact person. 

3. From the menu bar, select the entry Device -> Access Control -> Set reset all PINs 
authorization key to open a window with this name. 
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4. Enter the authorization key received in the input field. 

5. Confirm the input with OK. 

▸ If the input was correct, all PINs are reset to the default value 0000. 
 

8.10  Working with Configurations 
To ensure that the VariSCR emission controller interprets incoming data correctly and converts 
them to the desired control signals, it requires information on the device connected and the 
master control connected. This information is stored in a configuration file on the emission 
controller 

You need the MICT for the following tasks: 

– Creating configuration files 

– Opening configuration files from a storage device 

– Processing configuration files 

– Saving configuration files on a storage device 

– Download configuration files to the emission controller 

– Upload configuration files from the emission controller 

– Displaying current and saved runtime data 
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8.10.1 Create, Open, Save 

 

Click on the symbol to create a new configuration and select the entry Emission 
Controllers -> VariSCR Standard. 

 

 

Click on the symbol to open a saved configuration. 

 

 

Click on the symbol to save the configuration currently displayed in the MICT to 
a storage device. 
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8.10.2 Upload, Download 

 

Click the symbol to upload the current configuration from the VariSCR emission 
controller to the MICT. If applicable, the MICT first establishes a connection to 
the device connected. 

 

Click the symbol to download the configuration in the MICT to the emission 
controller. This function can only be executed when the emission controller is in 
manual mode. This action overwrites the existing configuration on the device. If 
applicable, the MICT first establishes a connection to the device connected. 

  

 

Existing configuration is cleared! 

If you download a configuration to a VariSCR emission controller the 
previously used configuration is deleted and the new settings are 
immediately implemented. 

  
 

8.10.3 Compatibility Information 

 

If you upload a configuration from the VariSCR emission controller to the MICT that does not 
correspond to the status of your MICT, or if you open this type of configuration in the MICT, the 
following situations may occur: 

– No values are present in the configuration for certain MICT functions. The MICT assumes the 
standard values for these functions. 

– The configuration contains function values that are not support by the MICT. 

The following situations can occur if you download a configuration from the MICT to a VariSCR 
emission controller whose firmware does not correspond to the status of your MICT: 

– No values are present in the configuration for certain firmware functions. The firmware 
continues to use the preset values for these functions. 

– The configuration contains function values that are not support by the firmware. 

If you download a configuration to the emission controller and are notified of functions that are 
not supported by the MICT, you should check the emission controller settings. Re-upload the 
configuration from the emission controller to the MICT. You can then see which settings are not 
transmitted to the MICT. 

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the 
emission controller functions without restriction. 
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8.11  Configuration 
The window opens after you select the device type for a new configuration or an existing 
configuration or have uploaded one from the device. You can make changes to the configuration 
by selecting an entry from the navigation bar. The corresponding configuration data are then 
displayed in the configuration section and can be processed. The following sections will 
describe the settings and adjustments you can implement in the different areas. 

  

 

Indication of invalid entries 

An invalid selection or invalid input values are highlighted by pulsating 
warning signs on the configuration pages of the MICT. Additional 
information is provided in the status bar. 

Example: 
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8.11.1 Inputs/Outputs – Control Setup 

  

To make changes, approval for the access level Advanced Service is required. 

Selection 
– Input 

For the function of the VariSCR emission controller, only the value Exhaust control SCR can 
be set. 

– Output 
Currently no output can be selected. 

– External manual/automatic selection enabled 
Disable the check box to deactivate the Manual/Auto switch on the emission controller. The 
emission controller may then only be used in manual mode via the MICT with the relevant 
authorization. 
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– Enable start/stop enabled 
Activate the checkbox to enable the binary input Start/Stop on the emission controller. This 
input is used to start the device from the master control. 

– External engine running enabled 
Activate the checkbox to enable the binary input Engine Running on the emission controller. 

 

8.11.2 Exhaust Control – Parameter 

  

  
Set the following parameters: 

– Intake NOX Low Pass Filter 
Activate this option and change the cut off frequency. A lower cut off frequency causes the 
NOX sensor to react more slowly. 
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– Outlet NOX Low Pass Filter 
Activate this option and enter the cut off frequency. A lower cut off frequency causes the NOX 
sensor to react more slowly. 

– Catalyst Operating Temperature Range 
Define the temperature range in which the catalytic converter may be operated. Observe the 
specifications of the catalytic converter manufacturer. 

– NOX Sensor Start Temperature 
The displayed value depends on the NOX sensors used and cannot be changed. This 
value is for information only. 

– Injection Start Temperature 
Lower limit of the operating temperature at which the injection of AdBlue® into the 
catalytic converter is started. 

– Reference Temperature 
Internal value for the calculation of temperature-dependent corrections of the control 
system. 

– Overtemperature 
Upper limit of the operating temperature. If the overtemperature is reached, the Catalyst 
Overtemperature output is switched. This output should be used as signaling for the 
master control. 

– Stop Temperature 
The stop temperature depends on the overtemperature. When the stop temperature is 
reached, injection is stopped. This value is for information only. 

– Error Temperature 
When the error temperature is reached, the emission controller goes into the error 
mode. This value is for information only. 
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8.11.3 Exhaust Control – SCR – Pump Setup 

  

  

Set the following parameters of the pump: 

PID Controller 
If necessary, change the basic setting for the PID control of the pump. This can be adjusted 
during operation via the runtime adjustments (see Runtime Adjustments – Pump on page 93). 
When you make the settings, you can be supported by the trend views in the runtime data (see 
Runtime Data – Trends on page 85). 

– Target 
Enter the target value for the pump pressure. 



8 Settings via the MICT 
 

Rev. 06/2020 67 

Cooling 
You use the switch-on and switch-off level to define the corresponding limit values for cooling of 
the dosing valve. When the device is switched off, the pump ensures cooling for the time 
specified in the corresponding field. 
 

8.11.4 Exhaust Control – SCR – Pump Self Test 

  

You can activate and adjust two types of pump self-test for pressure and speed monitoring, 
respectively: 

– Initial Self Test 
The initial self test is performed once after starting the emission controller and after each 
error acknowledgment. 
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– Continuous Self Test 
The continuous self test is performed permanently during operation of the emission 
controller. 

Refer to the section Pump Self Test on page 44. 

You have the following options: 

– Overall Timeout 
Enter the total time for the initial self-test, after which the pressure and speed tests must be 
completed successfully at the latest. If the time is not observed, the self-test is aborted and 
the emission controller goes into the error mode. 

– Pressure 
Activate the checkbox to monitor the pump pressure. 

– Timeout 
If the pressure is not within the specified minimum and maximum values within the 
specified time, the self-test is aborted and the emission controller goes into error mode. 

– Min. Pressure/Max. Pressure 
Enter the limits for the pump pressure. 

– Speed 
Activate the checkbox to monitor the pump speed. 

– Timeout 
If the pump speed is not within the specified minimum and maximum values within the 
specified time, the self-test is aborted and the emission controller goes into error mode. 

– Min. Speed/Max. Speed 
Enter the limits for the pump speed. 

 



8 Settings via the MICT 
 

Rev. 06/2020 69 

8.11.5 Exhaust Control – SCR – Dosing Valve 

  

Set the parameters of the dosing valve: 

PID Controller 
If necessary, change the basic setting for the PID control of the dosing valve. This can be 
adjusted during operation via the runtime adjustments (see Runtime Adjustments – Dosing Valve 
on page 94). When you make the settings, you can be supported by the trend views in the 
runtime data (see Runtime Data – Trends on page 85). 

– NOX 
Enter the target value for the NOX sensor at the outlet of the catalytic converter. 

– Sampling Time 
If required, change the sampling time of the PID control. 

– Start Delay 
If necessary, change the start delay of the PID control. 
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– Injection Enable 
Enter the NOX value at the intake from which the injection is to take place. 

– Heater 
Activate the heater via the corresponding checkbox. You define the respective limit values 
via the Switch On Level and Switch Off Level. 

 

8.11.6 Exhaust Control – SCR – Feed Forward Control 
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On this configuration page you define a characteristic curve for the feed forward control. A 
maximum of eight points can be configured for this purpose. Each point consists of the dosing 
rate in dependence of the exhaust gas mass flow. In addition, the maximum dosing rate can also 
be set for each point of the characteristic curve. This setting must be determined once for each 
SCR system. This is supported by an Excel® file that you can find on the storage device included 
with the controller. For a detailed description of this procedure, see Determine Values for Feed 
Forward Control on page 98. 

Default 
Use the button to restore the default settings. 
 

8.11.7 Exhaust Control – Check 

  

In this view, you make general settings for the verification of the measured NOX values. 
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You have the following options: 

– NOX Intake Limit 
Set the maximum permissible NOX value at the intake. If this value is measured by the NOX 
sensor for longer than the duration specified in the Time field, the emission controller enters 
the error mode. 

– NOX Sensor Difference 
Define the maximum permissible difference between the NOX values at the intake and outlet 
before starting injection. If this value is exceeded, the emission controller enters the error 
mode if the corresponding checkbox has been activated. If the checkbox is not activated, an 
information is logged in the Log. 

– NOX controller 
Define the maximum permissible deviation of the NOX value from the target value at the 
outlet. If this value is measured by the NOX sensor for longer than the duration specified in 
the Time field, the emission controller enters the error mode if the corresponding checkbox 
has been activated. If the checkbox is not activated, an information is logged in the Log. 
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8.11.8 Miscellaneous – Communication 

  

CAN SCR Catalyst Sensors 
To connect the catalytic converter sensors, activate the CAN SCR Catalyst Sensors field and 
select the J1939option. Enter 0 for the Source Address and select the 250 kbit/s Bitrate. 

CAN 
Via the field CAN, deactivate or activate the CAN interface of the device. 

– ALL-IN-ONE (J1939)/ J1939/CANopen 
Select the desired protocol, depending on whether you want to set the communication for 
the ALL-IN-ONE or for another master control. 
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– Source Address/CANopen Node ID 
In the protocol ALL-IN-ONE (J1939) and J1939 the source address can be assigned between 0 
and 253. In the CANopen protocol, a CANopen node ID from 1 to 127 can be assigned. Note 
that IDs cannot be assigned more than once. 

– Bitrate 
Select the desired data transfer rate from the list. In the protocol ALL-IN-ONE (J1939) and 
J1939, 250 kbit/s and 500 kbit/s are available for selection. In the CANopen protocol, a bit 
rate from 50 kbit/s to 1 Mbit/s can be set. For both protocols, we suggest the use of a baud 
rate of 250 kbit/s. 

RS485 

Via the field RS485, deactivate or activate the RS485 interface of the device. 

– RS485 Settings 

– Bitrate 
Select the desired data transfer rate from the list. The Modbus bit rate can be defined 
between 9,600 bit/s and 115,200 bit/s, the recommended value being 19,200 bit/s. 

– Parity 
Define if a parity bit is used and if the parity is to be even or odd. 

– Stopbits 
Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no 
parity has been selected. 

– Modbus Settings 

– Modbus Address 
The Modbus address can be assigned between 1 and 247. Note that IDs cannot be 
assigned more than once. 

– Mode 
Define if the data are transferred in the ASCII or RTU mode. 

  

 

Setting the transfer rate 

Please note that all devices connected with a bus must be set to the same 
transfer rate. 
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Field bus protocols 

No emission-specific values are currently available in the field bus 
protocols. 

  
 

8.11.9 Miscellaneous – Service Contact 
This configuration page can be viewed by all users, but changes can only be made with 
authorization for the Advanced Service access level. 

  

Service Contact 
In this area, you can store individual contact data. 
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8.12  Runtime Data 

 

Click on the symbol to open the window Runtime Data. The following sections 
will give you an overview of the data you can view on the individual tabs. 

You can print and record the runtime data. For this purpose, the following functions are at your 
disposal in the toolbar in the window: 

  

Symbol Function 

 

Prints the runtime data. 

 

Prints the runtime data to a PDF file. 

 

Opens the print preview. 

 

Starts the runtime data trace. 

 

Stops the runtime data trace. 

   

 

Save runtime data locally 

You should always save runtime data on the local computer and not on a 
network drive or external storage device. Trace files can only be moved 
freely once the recording is stopped. 
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Below the toolbar you will find the most important states and data of your system: 

 

– State 

– Warning 
The yellow status display indicates that a warning is pending. The currently pending 
warnings are displayed as a tooltip. Refer to the section Runtime Data – Message Log on 
page 87. 

– Error 
The red status display indicates that an error has occurred. The current errors are 
displayed as a tooltip. Refer to the section Runtime Data – Message Log on page 87. 

– Pump 
The status of the pump is displayed. Following statuses are possible: Stop, Ready, 
Operational, Cooling Time, Cooling Off, Cooling On, Error, Self Test, Manual. 
The diagram shows the current pressure as a bar and value. The green triangle indicates the 
target value. The tooltip displays the target value numerically. A red triangle at the 
beginning or end indicates that the display range has been exceeded or fallen below. 

– Valve 
The status of the dosing valve is displayed. Following statuses are possible: Stop, Ready, 
Running, Error, Manual. 
The diagram shows the current opening as a bar and value. 

– NOX 
For the NOX sensors, the values at the intake (top) and outlet (bottom) are shown in the two 
diagrams. The diagrams show the current values as bars and values. For the NOX value at the 
outlet, the target value is also indicated by a green triangle. The tooltip displays the target 
value numerically. A red triangle at the beginning or end indicates that the display range has 
been exceeded or fallen below. 

 



8 Settings via the MICT 
 

78 Rev. 06/2020 

8.12.1 Runtime Data – Overview 

  

You can find the following information in the window: 

Device 
The status displays provide information on the status of the emission controller. 

– Warning 
The yellow status display indicates that a warning is pending. Refer to the section Runtime 
Data – Message Log on page 87. 

– Error 
The red status display indicates that an error has occurred. Refer to the section Runtime 
Data – Message Log on page 87. 

– Offline 
The blue status display indicates that the emission controller is ready for operation, but that 
the injection conditions have not yet been fulfilled. 
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Mode 
The status displays provide information about the operating mode of the emission controller. 

– Configured 
The following status displays are possible: 

– Green: A valid configuration has been downloaded to the connected emission controller. 

– Red: An error has occurred while downloading the configuration or there is no 
configuration on the device 

– Configured 
The following status displays are possible: 

– Green: The emission controller is in manual mode. Refer to the section Manual and 
Automatic Operation on page 45. 

– Yellow: Manual settings are made (e.g. manual pump adjustment, manual valve 
adjustment). 

– Red: An error occurred. 

– Automatic 
The following status displays are possible: 

– Green: The emission controller is in automatic mode. Refer to the section Manual and 
Automatic Operation on page 45. 

– Red: An error occurred. 

Pump 
The following status displays are possible: 

– Green: The pump is in operation. This also includes the cooling of the dosing valve. 

– Yellow: The pump is adjusted manually or is in self test. 

– Red: An error occurred. 

Pump Pressure [bar] 
The target value and the actual value of the pressure at the dosing valve are given as values and 
shown in diagrams. 

SCR 
The status displays provide information on the status of the SCR system. 

– State 
The following status displays are possible: 

– Green: The SCR system is working correctly. 

– Yellow: The emission controller is in manual mode. Refer to the section Manual and 
Automatic Operation on page 45. 

– Red: An error occurred. 
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– Mode 
The following status displays are possible: 

– Green: The feed forward control and the PID control are taken into account. 

– Yellow: Only feed forward control is taken into account. 

– Red: An error occurred. 

– Heater 
The green status display indicates that the heater of the dosing unit is working. 

Dosing Valve Opening [%] 
The current percentage opening of the dosing valve is indicated as a value and shown in the 
diagram. 

AFR, Stepper Motor, Stepper Motor [%] 
These functions are currently not available. 
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8.12.2 Runtime Data – Sensors 

  

The window displays detailed information about the sensors used in the SCR system. Basically, 
the colors of the status displays have the following meaning: 

– Green: No error 

– Yellow: Out of the respective value range 

– Red: Errors 
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The following information is displayed in the individual areas of the window: 

Catalyst Intake / Catalyst Outlet 
For the two NOX sensors at the intake and outlet of the catalytic converter, you will receive the 
following information: 

– NOX 
The green status display indicates that the NOX measurement of the sensor is working 
correctly. In addition, the status of the NOX measurement and the actual measured value are 
displayed. 

– Oxygen 
The oxygen content is also determined by the NOX sensor. The green status display indicates 
that the measurement of the oxygen content is working correctly. In addition, the status of 
the oxygen measurement and the actual measured value are displayed. 

– Power 
The green status display indicates that the supply voltage is within the permissible range. In 
addition, the status of the supply voltage is displayed. 

– Heater 
The green status display indicates that the heating of the NOX sensor is active and is 
working without errors. In addition, the status and operating mode of the heater are 
displayed. 

– Online 
The green status indicator indicates that the respective NOX sensor is communicating with 
the emission controller. 

Temperature 
The temperature module consists of two temperature sensors for intake and outlet. 

– Catalyst Intake / Catalyst Outlet 
The current measured value and the status of the respective sensor are indicated for each of 
the two temperature sensors. 

– ECU 
The temperature of the temperature module and the status of the entire module will be 
indicated. 

– Online 
The green status indicator indicates that the temperature module is communicating with the 
emission controller. 
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8.12.3 Runtime Data – Dosing Unit 

  

The window displays detailed information on the dosing unit. 

Dosing Unit 

– Pressure 
Current AdBlue® pressure at the dosing valve 

– Temperature 
Current temperature at the dosing valve 

Pump 

– Target 
Target value of the speed of the pump as value and diagram 

– Actual 
Actual speed of the pump as value and diagram 
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Manifold 

– Pressure 
Pressure measured by the MAP sensor in the manifold 

– Temperature 
Temperature measured by the MAT sensor in the manifold 

– Exhaust Mass Flow 
Mass flow equivalent calculated from the measured values of the MAP and MAT sensors. 

Dosing Unit Controller 

– Feed Forward Control 
Opening angle resulting from the feed forward control. 

– PID controller 
Opening angle resulting from PID control. 

– Max. Dosing Opening 
Maximum value defined in the feed forward control (see Exhaust Control – SCR – Feed 
Forward Control on page 70). 

– Opening 
Actual opening angle of the dosing valve resulting from the feed forward control and the PID 
control. 
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8.12.4 Runtime Data – Trends 

  

The trend view shows you the chronological history of essential values of your SCR system. The 
information provided can help you optimize the PID controllers of the pump and dosing valve. 

The recording is started as soon as the runtime data window is opened and deleted as soon as 
the window is closed again. The trend view is not available in the runtime data trace. 

You can choose between two views: 

– Pump 
Trend of the pump pressure and the pump speed (target and actual values) as well as the 
PID parameters of the pump 

– Exhaust 
Trend of the NOX values at the intake and outlet, as well as the PID parameters and the 
percentage opening of the dosing valve. In addition, the lower diagram shows an area with a 
red background where the value of the dosing valve opening may be located. The upper limit 
is the maximum permissible dosing valve opening. 
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You have the following options: 

– Save 
The recorded values are saved on the connected computer as a CSV file. You can open and 
process these in other programs such as Microsoft Excel®. 

– Clear 
Deletes previously recorded data and starts a new recording. 

– Pause 
The displaying of the values is paused. However, the recording of the values continues in the 
background. 

– Show/Hide values 
Use the checkboxes in front of the values to specify which values are displayed in the 
diagrams. 
The color of the fields behind the checkbox corresponds to the color of the respective curve 
in the diagrams. The small symbol within the color fields indicates in which diagram the 
corresponding value is displayed and to which scale the value refers. The label on the scale 
does not always reflect all the values displayed. 
Examples: 

 – The actual value of the pump pressure is shown as a blue curve in the upper 
diagram and the values are read off the left-hand scale. 

         – The P parameter of the PID control of the pump is shown as a green curve in 
the lower diagram and the values are read on the right scale. 

– Change displayed time period 
Using the drop-down menu, you can select the time period that is displayed in the diagrams. 
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8.12.5 Runtime Data – Message Log 

  

In the view Message Log, information, warnings and errors are listed. 

The following information is provided: 

– Operating Hours 
Operating hours counter reading at the time of message 

– Time 
Time and date cannot be shown for VariSCR emission controllers. 

– Category 
Message type (information, warning, error) 

– Message 
Message text; you can find more information on the message text in the following sections. 
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You have the following options: 

– Automatic scrolling 
If this box is checked, the system automatically displays the last list entry until a new event 
occurs. 

 

8.12.5.1 Information 
Information 

Configuration changed. 

Device (firmware version) started at a supply voltage of value. 

Device switched off. 

Message log cleared. 

NVRAM formatted. 

One or more messages are lost due to exhausted memory pool or 
message queue overrun. 

Shutdown timestamps cleared. 

Dosing valve info. 

Output catalyst overtemperature is set. 

  
For each information, the status of the emission controller at the time the information occurred 
is provided. Additional parameters are provided if necessary. 
 

8.12.5.2 Warnings 
Warning 

Cpu usage. 

General warning. 

Reset life time. 

Use backup life time. 

SCR pump: Low pressure 

SCR pump: High pressure 

SCR pump: Low feedback 

SCR pump: High feedback 

Low catalyst outlet temperature 

High catalyst outlet temperature 
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Warning 

High dosing valve temperature 

Low dosing valve temperature 

  
For each warning, the status of the VariSCR emission controller at the time the warning occurred 
is provided. Additional parameters are provided if necessary. 
 

8.12.5.3 Errors 
Errors 

CAN handler message queue full. 

Error triggered by command. 

Coprocessor handler message queue full. 

General error. 

Input handler message queue full. 

Low Power 

Output handler message queue full. 

Over current. 

Over temperature. 

Power failure. 

Timeout. 

Background task message queue full. 

Control handler message queue full. 

SCR pump selftest failure in state. 

SCR dosing valve failure. 

Sensor 

Bus 

  
For each error, the status of the VariSCR emission controller at the time the error occurred is 
provided. Additional parameters are provided if necessary. 
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8.12.6 Runtime Data – Diagnostics 

  

In this screen, you can find the following information: 

Operation Mode 
The operation mode section shows which operation mode (Manual or Automatic) is currently 
active and how the operation mode was adjusted. Here, there are the following two options: 

– Control 
Displays whether the operation mode was adjusted using the MICT or the switch 
Manual/Auto on the device (Hardware). 

– Mode 
The set operating mode is displayed. 

– System 
At present, only the system status Operation SCR is possible. 
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SCR 
In this area the current states of the emission controller, the pump and the heating are 
displayed. These serve as an overview of the overall system. 

AFR 
This function is currently not available. 

Measurements 
– Supply voltage 

Current supply voltage of the emission controller 

– Current Temp. 
Current temperature of the board 

– Max. Temp. 
Maximum board temperature reached since the last time the emission controller was 
switched on 

– Min. Temp. 
Minimum board temperature reached since the last time the emission controller was 
switched on 

Max. Step Loss 
This function is currently not available. 
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8.12.7 Runtime Data – Information 

  

In this view, you can find an overview of the device and version data. You can also print the 
current runtime data or, in case of problems, send them to the MOTORTECH Service Department 
via fax or as a PDF file via e-mail. For fast support, we will then immediately have all required 
information. 
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8.13  Runtime Adjustments 

 

Click on the symbol to open the window Runtime Adjustments. This window is 
only available to users with authorizations starting with access level Service. 

  

 

Runtime adjustments are implemented directly 

All runtime adjustments are implemented directly without requiring the 
input to be confirmed and are retained even in the case of a VariSCR 
emission controller restart. 
Changes that have been saved in the device configuration are only 
displayed after re-uploading the device configuration in the MICT's main 
window. 

  
 

8.13.1 Runtime Adjustments – Pump 

  

The PID control of the pump can be corrected during operation of the device. Use the arrow keys 
above and below the decimal digit you want to increase or decrease. Alternatively you can place 
the mouse pointer over the respective digit and then change the displayed value with the scroll 
wheel of the mouse. 
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The correction of the control is immediately implemented and also remains in place if the device 
is restarted. The configuration defined in the device is changed directly. 
 

8.13.2 Runtime Adjustments – Dosing Valve 

  

The PID control of the dosing valve can be corrected during operation of the device. Use the 
arrow keys above and below the decimal digit you want to increase or decrease. Alternatively 
you can place the mouse pointer over the respective digit and then change the displayed value 
with the scroll wheel of the mouse. 

The correction of the control is immediately implemented and also remains in place if the device 
is restarted. The configuration defined in the device is changed directly. 
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8.13.3 Runtime Adjustments – Gas Mixer 

  

This function is currently not available. 
 

8.14  Log 

 

Click on the symbol to open the window Log. This window is only available to 
users with authorizations starting at the access level Advanced Service. 
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The window Log serves to support error diagnostics by MOTORTECH. 

– Automatic scrolling 
If the function is active, the view panel focuses on the latest message. 

– Log level 
The selection of the log level is specified by MOTORTECH if needed. 

– Write log to file 
This checkbox activates or deactivates, respectively, the saving of the logged data in a 
selected file. If the function is disabled, the logged data are merely shown on the display. 

– Select file 
With this button, you can select a file to which you want to save the logged data. 

If you are prompted to create a log file in the case of a service request, proceed as follows: 

1. Open the window Log via the toolbar or the menu bar. 

2. Select a path with the Select file button and enter the file name for the log file. 

▸ If the file does not yet exist, it is automatically created with the extension .log. 

3. Activate the checkbox Write log to file. 

4. Select the level specified by MOTORTECH from the list Log level. 

5. Leave the window open. 

▸ The log messages are logged both in the window and in the selected file. 
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9.1  Start-up 
To start up the SCR system safely, proceed as follows: 

1. Install the SCR system. 

2. Set up the AdBlue® circuit so that the dosing unit does not overheat. 

3. Adjust the configuration of the VariSCR emission controller, but first for the feed forward 
control (configuration page: Exhaust Control –SCR – Feed Forward Control) use the preset 
values. 

4. Start the engine. 

5. Adjust the mixture control so that the NOX sensor before the catalytic converter measures a 
NOX value that corresponds to the engine manufacturer's specifications. 

6. Using of a supplied Excel® file, the optimized values for the feed forward control must now 
be determined and entered into the configuration in MICT. On this, read the section 
Determine Values for Feed Forward Control on page 98. 

7. Download the modified configuration to the emission controller. 

▸ The start-up is finished. 
 

9 Operation 
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9.1.1 Determine Values for Feed Forward Control 
The values for the feed forward control must be recalculated once for each SCR system. The 
determination should also be carried out separately for two identical cylinder banks for a V-
engine. 

The Excel® file, which is located on the storage device enclosed with the emission controller, 
supports you in calculating the required values. The determined values are entered in the MICT 
in the configuration page Exhaust Control – SCR – Feed Forward Control. 

Proceed as follows: 

1. Start the MICT on your computer and connect to the VariSCR emission controller. 

2. Open the supplied Excel® file (menue item: Documentation -> VariSCR) on your computer. 

3. Define eight load points in the Excel® file and enter the power and speed in the columns 
Power and RPM . 
Note: 
The load points should cover the range between low load (no idling) and full load. 
Example: 

 
4. Run the engine into the first load point. 
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5. Read off the pressure and temperature in the manifold in the window Runtime Data – Dosing 
Unit and enter the pressure value in the column MAP and the temperature value in the 
column MAT in the Excel® file. 
Example: 

 
6. In the Runtime Data – Sensors window, check the NOX value before the catalytic converter. It 

should correspond to the value set via the mixture control and be almost constant during the 
measurement. 
Tip: 
Alternatively, the NOX values at the intake and outlet can also be read in the overview below 
the toolbar. 
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7. Enter the value in the column NOx inlet of the Excel® file. 
Example: 

 
8. Open the dosing valve manually via the menu item Device -> Manual Valve Adjustment until 

the NOX value at the catalytic converter outlet corresponds to the desired final value (e.g. 
30 ppm) in the window Runtime Data – Sensors. Refer to the section Manual Valve 
Adjustment on page 54. 

9. Enter the value for the percentage opening in the column Target Valve Opening. 
Example: 
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10. Repeat points 4. to 9. for the remaining seven load points. 

▸ The colored (green, yellow, red) columns in the Excel® file now contain the optimized 
values for the feed forward control. 

11. Enter the values of the colored columns into the configuration page Exhaust Control – SCR – 
Feed Forward Control  in the MICT. 
Example: 

 
12. Download the changed configuration to the emission controller. 

▸ The start-up of the emission controller is completed and the control is set according to 
the entered parameters. 
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Save configuration to file 

If you save the configuration as a file after start-up, you can download it to 
the new device when replacing the emission controller. A new calibration is 
then not necessary. 

  
 

9.2  Firmware Update 
Using the MOTORTECH Flash Tool, you can update the firmware of your VariSCR emissions 
controller. The program is provided on the storage device (USB flash drive or CD-ROM supplied). 

Install MOTORTECH Flash Tool 
Install the MOTORTECH Flash Tool as follows: 

1. Start the installation: 

– Via the menu: 
Start the file Start.exe on the storage device. Start the installation routine for the 
MOTORTECH Flash Tool via Software -> MOTORTECH Flash Tool -> Install MOTORTECH 
Flash Tool. 

– Directly from the storage device: 
Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage 
device in the subdirectory Installation and for example named as follows: MOTORTECH-
Flash-Tool-0.9.00003-setup.exe. 

2. Install the program. 
Follow the instructions of the installation routine. Note that the license agreement terms 
must be accepted before using the MOTORTECH Flash Tool. 

3. If the USB driver is not yet installed, also install it via the menu or directly from the storage 
device. 

– Via the menu: 
Software -> USB Drivers -> Install USB Drivers 

– Directly from the storage device: 
Start the exe file in subdirectory Drivers 
(e.g. CDM v2.10.00 WHQL Certified.exe). 

▸ The MOTORTECH Flash Tool is set up. You can now connect your computer to the 
emission controller via the USB interface. 
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Menu Bar and Toolbar 
After launching the MOTORTECH Flash Tool, the following functions are available to you via the 
icons on the toolbar and the entries in the menu bar: 

Symbol Menu Function 

 

File -> Open Opens a firmware file. 

  File -> Quit Exits the program. 

  View -> Extended file information 
view 

Fades in / out additional information of the 
firmware file. 

  View -> Extended connection 
settings 

Fades in / out additional information and 
settings of the connection to the device. 

 

View -> Reload file Reloads the file information of the selected 
firmware file. 

 

Device -> Search devices Restarts the search for connected devices. 

 

Device -> Flash device Starts the update process or downgrade 
process. 

  Settings -> Language Opens the window Select Language in 
which you can change the interface 
language of the program. 

  Help -> Help Opens the online help function. 

  Help -> About MOTORTECH Flash 
Tool 

Opens detailed information on the 
program. 

  

Start Firmware Update 
  

 

Access control for firmware update 

If you have activated the access control for the ignition controller, you need 
the PIN for the level Master for the firmware update. For more information 
read the section Access Control for the VariSCR Emission Controller on 
page 57. 

   



9 Operation 
 

104 Rev. 06/2020 

 

Backup the existing configuration 

Your device's configuration may be lost if the firmware update is not 
performed properly. Always backup the existing configuration via the MICT 
prior to performing an update. For more information read the section 
Working with Configurations on page 59. 

  

To start a firmware update, proceed as follows: 

1. If an MICT is connected with the emission controller, disconnect this connection. 

2. Start the MOTORTECH Flash Tool via Start -> Programs -> MOTORTECH -> MOTORTECH Flash 
Tool -> x.x.x (e.g. 0.9.00003) -> MOTORTECH Flash Tool. 

▸ The MOTORTECH Flash Tool will now start. 

▸ The software automatically checks all ports for connected devices. 

3. In the Status section under Device, check if your device has been recognized properly. 

▸ If the MOTORTECH Flash Tool does not recognize a device that is connected to your 
computer via the USB interface, you can usually still carry out a firmware update. To do 
so, observe the instructions in the information windows of the MOTORTECH Flash Tool 
for the following steps. 

4. Select in area File using the Select button the desired update file. 

5. By reading the displayed file information, ensure that the update file is correct for your 
device. 

6. Start the update process using the Flash button or using the menu or toolbar. 

▸ The emission controller will be restarted automatically. 

▸ Now, a window opens informing you about the firmware version currently used on your 
emission controller and also about the relevant update version. 

7. Confirm with Yes to proceed with the update process. 

▸ Now the update will start. 

▸ If the firmware update was successful, you will see a relevant message. 

8. After a successful firmware update, check all configuration data. 

  

 

Downgrade process 

The process for a downgrade is largely the same as the update process. You 
will only be informed that a new firmware has been installed on the device. 
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Help with connection problems 

If a correctly connected device is not found during the automatic search, 
this can, for example, be because too many communication interfaces are 
assigned and must be checked. In this case, an interface from the drop-
down list Port in the area Connection can be selected and thus specified. 

If the desired port is not yet displayed in the list or if the problem should 
continue, an adjustment of the time-outs for the connection helps. The 
time-out settings are displayed in the main view by the following entry in 
the menu bar: View -> Extended connection settings 

Enter the following settings: 

– Update Request Timeout 
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. 
An extension of the time-out can be an advantage, especially with 
connection problems that occur because the computer has many 
assigned ports. 

– Start Timeout 
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. A 
time-out change can be an advantage, especially with connection 
problems that occur because the communication between the computer 
and the device has been interrupted. 
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10.1  Troubleshooting 
If the VariSCR emission controller detects any error, the LED status starts blinking in red. You 
can find details about status signaling in the following information box. In automatic mode, the 
binary output Error is also activated in the event of a fault and the corresponding LED lights up. 
Using the MICT you can see the type of error occurred. Refer to the section Runtime Data – 
Message Log on page 87. 

  

 

Status signaling 

The status of the VariSCR emission controller is signaled via the LED Status. 

– Flashing green: Error-free operation 

– Flashing orange: Warning 
Warnings can be acknowledged by simultaneous pressing of buttons 
Open and Close (in manual mode) or by the external reset signal. 
Warnings can for example be caused by: 

– Overload of the device 

– Overtemperature or over current error confirmed by MICT. 

– Flashing red: Error 
Errors can be acknowledged by simultaneous pressing of buttons Open 
and Close or by the external reset signal. Errors can for example be 
caused by: 

– Overtemperature 

– Low voltage 

– Over current 

– Alternate flashing of red and green: 
The supply voltage for the device was too low during start up. 

  
 

10.2  Possible Faults 
Low Power 
Supply voltage has dropped below 11 V. 

Potential causes: 

– The power supply is dimensioned too small. 

– The battery is worn out. 

– The wiring for the power supply is defective. 

– The wiring for the power supply is routed incorrectly. 

10 Errors 
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Overtemperature 
The temperature of the board of the VariSCR emission controller has been exceeded. 

Potential causes: 

– The ambient temperature is too high. 

– Air circulation around the device is insufficient. 
 

10.3  Acknowledging Faults 
In manual mode, you have the following options for acknowledging operational errors: 

– Via Error acknowledge in the MICT 

– By pressing the Open and Close button simultaneously 

In automatic mode, you have the following options for acknowledging operational errors: 

– The master control sends a signal to the binary reset input 

– By pressing the Open and Close button simultaneously 

– Via Error acknowledge in the MICT 

Critical errors can only be acknowledged by switching the device off and on. 

  

 

Error confirmation in automatic operation 

If the VariSCR emission controller is in automatic mode and an error 
immediately reoccurs after the acknowledgment of this error via the MICT, 
switch over into the manual mode before re-acknowledging the error again. 
After you have acknowledged the error, you can correct a defective 
configuration and transfer it to the device via download. 

  
 

10.4  Customer Service Information 
You can reach our customer service during business hours at the following phone and fax 
number, or by email: 

Phone:  +49 5141 93 99 0 

Fax:  +49 5141 93 99 99 

Email:  service@motortech.de 
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10.5  Returning Equipment for Repair/Inspection 
To return the device for repair and inspection, obtain a return form and return number from 
MOTORTECH. 

Fill out the return form completely. The completely filled out return form guarantees fast, 
uncomplicated processing of your repair order. 

Send the device and the return form to one of the two addresses below or to the nearest 
MOTORTECH representative: 

  
MOTORTECH GmbH 
Hogrevestr. 21-23 
29223 Celle 

Germany 

Phone:  +49 5141 93 99 0 
Fax:  +49 5141 93 99 98 

www.motortech.de 
motortech@motortech.de 

MOTORTECH Americas, LLC 
1400 Dealers Avenue, Suite A 
New Orleans, LA 70123 

USA 

Phone:  +1 504 355 4212 
Fax:  +1 504 355 4217 

www.motortechamericas.com 
info@motortechamericas.com 

  
 

10.6  Instructions for Packaging the Equipment 
For return shipment, equipment should be packaged as follows: 

– Use packaging material that does not damage the equipment surfaces. 

– Wrap the equipment with sturdy materials and stabilize it inside the packaging. 

– Use sturdy adhesive film to seal the packaging. 
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11.1  Spare Parts and Accessories 
For spare parts and accessories, please refer to our current Product Guide, which is available for 
you to download on the internet at www.motortech.de. 
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